Developing an Effective Resume
A resume is one of the most important documents in your internship or job search. It is a personal marketing tool
that may lead to an interview. Think of your resume as a summary of the knowledge, skills and experiences you will
bring to a specific position or industry.
Format: What should my resume look like?
 Resume formats should be readable, well organized and concise. Most employers spend fewer than 20-30
seconds reviewing a resume.
 Avoid using resume templates! Creating your own document demonstrates your computer skills and
initiative.. Templates can be difficult to edit, download and format over time.
 One page resumes are preferred by employers for interns and entry-level opportunities. A two page
resume is acceptable for experienced candidates, and within many non-profit or academic fields.
What should my resume include?
Your resume is unique to YOU. It should include your skills, experiences and accomplishments. A resume should
include:
 Contact information: Tip: Avoid using “headers” if possible, as MS Word may not print or fully download this
information. Avoid text boxes as well, as this can lead to difficulty with future edits.
 Objective, Summary Statement or Skills Summary: Answers the questions, what do I want to do, where, and
what can I offer?
 Education: School, Degree(s), Graduation date, or level of student (currently a Sophomore, Junior, etc.)
 Skills (optional): Describes skills that are relevant to the job sought or above and beyond what is expected.
 Experiences: Work, internship and/or volunteer experiences, accomplishments, and related leadership roles.
 Honors & Activities: Honors/scholarships awarded, extracurricular activities and leadership roles

Resume Do’s and Don’ts
DO
 Use conservative font styles (Times New Roman,
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Arial, Arial Narrow, or similar styles). Font size may
range from 10-12.
Set page margins between 0.5 and 1.0 inches (top,
bottom, left and right).
Use bullet points to keep text action-focused and
concise.
Include accomplishments.
Print your resume using a laser printer; white or offwhite bond paper is preferred. (Dark paper does not
copy or fax well!)
Keep your resume up to date, with correct addresses
and phone numbers!
ALWAYS include a cover letter when mailing your
resume to an employer.
Proofread carefully!
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DON’T
 Don’t include personal pronouns such as I, me , or





my.
Don’t include: age, marital status, height/weight, birth
date, or a photograph.
Don’t abbreviate (other than for the states - SC).
Don’t exaggerate or lie on your resume. It will catch
up with you.
Don’t include “References upon Request” at the
bottom of your resume. Most employers who want
references will ask for this. Use the space on your
resume to share more details about you and your
experiences.

Resume
OBJECTIVES, SUMMARY STATEMENTS, & SKILLS SUMMARIES
Do you need an objective or summary?
As a rule, the first line of your resume should communicate to the reader the type of position or industry you
are seeking. If your major directly relates to the job you are seeking, (for example, you are applying for an
accountant position and you are an Accounting major), you may not need an objective or summary statement.
However, for most liberal arts majors, this is not the case. For example, a Communications major may be interested
in many career areas, so how does a potential employer know what types of jobs or careers would be of interest to
you or what skills you have to offer for those jobs? An objective or summary is recommended in that it tells the
reader the type of job/career you are targeting, and describes skills or ways you can contribute to the
specific job, industry or career. If done effectively, this is a very powerful tool in getting your resume noticed.

I’m including a cover letter, so do I still need an objective or summary?
Again, although optional, an objective or summary allows you to reinforce your goals:
1. In case the employer reads your resume first; and
2. To reinforce how you meet the qualifications and the requirements of the position
What is the difference between an objective statement and a summary?
An objective statement is a concise, position centered statement describing the value you can add and the needs
you can fulfill. An objective may include a brief statement of skills and qualifications that you will bring to the position.
A professional summary or skills summary is longer and provides more detail than an objective statement.
Summaries identify the type of position you are seeking and provide lengthier descriptions of skills and qualifications.
Objective Statement Examples:
Seeking a statistical research position utilizing my experience with survey development and evaluating sales data.
To obtain an internship in the Human Resources field, with particular interests in recruitment and training.
Professional Summary Example:
Recent graduate with Bachelor’s degree in Business and a concentration in Marketing seeking a Marketing
Associate position. Offer solid understanding of marketing strategies illustrated through academic projects and an
internet venture that continues to develop and test theoretical marketing strategies and business management in the
areas of:

 Conceptual Planning
 Project Development

 Web-Based Marketing
 Competitive Analysis

 Advertising Campaigns
 Media/Client Relations

Skills Summary Example:

 Passionate writer and reporter. Experienced in writing feature articles, short stories, biographies, editorial




pieces, press releases, research reports, and creative ad copy.
Well-versed in copy editing, transcription/editing of interviews and proofreading, most recently as an editor for a
weekly college magazine.
Strong vocabulary and command of the English language; familiarity with MLA, Chicago, APA and Turabian
writing styles
Commitment to meeting deadlines.
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What to Include
Your Name Here
email@yourmail.edu
Permanent Address
Address
Phone

Two addresses may be used if you are at school. Avoid
unprofessional email addresses.

School Address
Address
Phone

SUMMARY or OBJECTIVE
Although this section is not required, you may summarize your skills/experience in narrative or list form or tell
what you are seeking. Or combine both in a summary. DO NOT USE “I”
EDUCATION
College of Charleston, Charleston, SC
Bachelor of ____________, Major, May 2014 (Use “Expected” date if incomplete)
Other information may include a minor(s), grade point averages, significant coursework, etc.
You may have more than one experience category, organized to focus on certain types of experiences or skills e.g.
“Research Experience” or just having ONE experience section may suffice for you.
RELATED EXPERIENCE
Name of Business or Organization, City, State
Title of your position, dates or employment or experience
 What is most relevant and important to your target reader? If you have relevant experience, you may want this
separate category to catch your reader’s attention.
 Within each category, list your experiences in reverse-chronological order (most recent experience comes first).
 Using action verbs, write short phrases to describe what you did that illustrates each skill. Be concise and
specific.
 Describe what you did, how you did it, who you did it for or with, what equipment or software you used, and
what the results were.
 Identify personal strengths and skills used to achieve your accomplishments.
Name of Business or Organization, City, State
Title of your position, dates of employment or experience
 Examine your resume as a whole to determine a strategic order for the presentation of your information.
 Quantify your results, if possible, and use commonly understood terminology but no acronyms.
 Always write out or explain technical terminology and abbreviations; do not leave anything to the employer’s
imagination or interpretation.
 Include full or part-time experiences, volunteer work, internships, teaching experiences….
 Avoid using diluted phrases such as “responsible for” or “in charge of.”
ADDITIONAL EXPERIENCE
Name of Organization, City, State
Title of your position, dates of employment or experience
 This section includes other experience which may not be relevant, but still shows experience.
ACTIVITIES (OR HONORS/AWARDS OR SKILLS OR VOLUNTEER)
List and describe organizations, position(s) held, volunteer work with dates of the experience or honors.
Depending on your experiences and skills, you could have more than one additional section listed here.
Important: Your sections and experiences should be listed in order of relevance to the job/internship. Within
each section, list experience from present to past. This is an just an example and you may choose a different
format to highlight your specific experience.
You may alter font sizes and margins.
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Action Verbs
Remember to use the correct verb tense
Communication

Creative

Financial

Helping

Technical

Addressed
Arbitrated
Authored
Corresponded
Directed
Drafted
Edited
Enlisted
Expressed
Formulated
Influenced
Interpreted
Interviewed
Lectured
Mediated
Moderated
Negotiated
Persuaded
Presented
Promoted
Publicized

Acted
Arranged
Conceptualized
Created
Designed
Developed
Directed
Engineered
Established
Fashioned
Founded
Illustrated
Integrated
Introduced
Invented
Imagined
Modernized
Originated
Performed
Planned
Publicized
Revitalized

Accounted
Administered
Allocated
Analyzed
Appraised
Assessed
Audited
Balanced
Budgeted
Calculated
Computed
Developed
Downsized
Forecasted
Generated
Managed
Marketed
Planned
Projected
Researched
Secured

Advised
Assisted
Clarified
Coached
Counseled
Developed Rapport
Encouraged
Educated
Empathized
Established
Relationships
Expedited
Facilitated
Familiarized
Guided
Mentored
Referred
Rehabilitated
Represented
Supported
Supplied
Rectified

Assembled
Calculated
Catalogued
Computed
Designed
Detected
Devised
Engineered
Fabricated
Integrated
Maintained
Operated
Programmed
Remodeled
Revamped
Solved
Streamlined
Trained
Upgraded
Translated

Office Support

Research

Management

Teaching

Writing

Allocated
Approved
Arranged
Catalogued
Classified
Compiled
Dispatched
Executed
Formulated
Generated
Implemented
Inspected
Monitored
Operated
Organized
Prepared
Processed
Purchased
Recorded
Retrieved
Scheduled
Specified
Systematized
Tabulated
Validated

Analyzed
Assessed
Collected
Compared
Critiqued
Diagnosed
Documented
Dissected
Evaluated
Examined
Extracted
Hypothesized
Identified
Inspected
Interpreted
Interviewed
Investigated
Located
Measured
Observed
Questioned
Reviewed
Screened
Summarized
Surveyed
Synthesized
Systematized

Administered
Assigned
Attained
Authorized
Chaired
Contracted
Consolidated
Coordinated
Delegated
Developed
Directed
Evaluated
Executed
Improved
Increased
Instituted
Lead
Managed
Met goals
Organized
Oversaw
Planned
Prioritized
Produced
Recommended
Reviewed

Adapted
Advised
Clarified
Coached
Communicated
Coordinated
Demonstrated
Developed
Educated
Enabled
Encouraged
Evaluated
Explained
Facilitated
Guided
Informed
Initiated
Instructed
Motivated
Persuaded
Presented
Set goals
Stimulated

Addressed
Authored
Composed
Drafted
Edited
Formulated
Indited
Inscribed
Printed
Produced
Publicized
Recorded
Reproduced
Scribed
Scripted
Transcribed
Wrote
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SAMPLE CHRONOLOGICAL RESUME

JOSEPH FAULKNER
232 Oak Lane, Charleston, SC 29412 ●

(843) 123-4567 ● faulknerjl@g.cofc.edu

SUMMARY
Recent graduate with strong research and writing skills, as well as experience working on Capital Hill, seeking a
position as a legislative assistant, with particular interests in Mid-Eastern policy and security issues.
EDUCATION
Bachelor of Arts in Political Science, May 2013
Minor in Anthropology
College of Charleston, Charleston, SC
Major GPA: 3.6/4.0
Overall GPA: 3.2/4.0
Related Coursework:
American Foreign Policy Process
Politics of Globalization

International Political Economy
American Politics and the Mass Media

STUDY ABROAD
Palestine and Arabic Studies Program, Birzeit University, West Bank, Palestine, Summer 2012
HONORS
Highly Distinguished Honor Student, 2011 - 2013
Phi Kappa Phi (Interdisciplinary Honor Society), 2012 - 2013
RELEVANT EXPERIENCE
Senior Thesis, College of Charleston, August 2012 - May 2013
 Wrote a 135 page empirical analysis of the Palestinian Authority and the Israeli Occupation of Palestine:
Governing Palestine
 Required one semester of extensive research and design and one semester of writing and editing
US House of Representatives, Office of Congressman James E. Clyburn, Washington, DC
Office Fellow, May - August 2012
 Provided aid to Staff Assistant and Office Coordinator, as well as occasional projects for legislative assistants
and staff
 Developed working knowledge of Capitol Hill practices and procedures; gained valuable communication skills in
dealing with constituent concerns
 Projects included US Farm Bill research, Medicare and Medicaid healthcare research
The Yard, College of Charleston, Charleston, SC
Staff Writer, August 2012 - May 2013
 Wrote several special interest and newspaper articles for College of Charleston student magazine
ADDITIONAL EXPERIENCE
Starbucks Coffee Co., Barista, October 2010 - May 2012
College of Charleston New Student Programs, Orientation Intern, May - August 2011
SKILLS

 Computer proficiency: Word, Access, PowerPoint, Excel, Publisher and Adobe Acrobat
 Arabic: beginner proficiency; basic literacy

ACTIVITIES
Student Government Association, College of Charleston, September 2012 - May 2013
 Acted as liaison between the student body and the Faculty Senate
This is an example of a resume in Chronological Style, which is the most common style used. All of the
entries are placed in reverse chronological order, starting with newest to oldest.
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SAMPLE PLAIN-TEXT
JOSEPH FAULKNER
232 Oak Lane, Charleston, SC 29412
(843) 123-4567
faulknerjl@g.cofc.edu
SUMMARY
Recent graduate with strong research and writing skills, as well as experience working on Capital Hill, seeking a
position as a legislative assistant, with particular interests in Mid-Eastern policy and security issues.
EDUCATION
Bachelor of Arts in Political Science, May 2013
Minor in Anthropology
College of Charleston, Charleston, SC
Major GPA: 3.6/4.0
Overall GPA: 3.2/4.0
Related Coursework: American Foreign Policy Process, International Political Economy, Politics of Globalization,
American Politics and the Mass Media
STUDY ABROAD
Palestine and Arabic Studies Program, Birzeit University, West Bank, Palestine, Summer 2012
HONORS
Highly Distinguished Honor Student, 2011 - 2013
Phi Kappa Phi (Interdisciplinary Honor Society), 2012- 2013
RELEVANT EXPERIENCE
Senior Thesis, College of Charleston, August 2013 - May 2013
* Wrote a 135 page empirical analysis of the Palestinian Authority and the Israeli Occupation of Palestine entitled
Governing Palestine
* Required one semester of extensive research and design and one semester of writing and editing
US House of Representatives, Office of Congressman James E. Clyburn, Washington, DC
Office Fellow, May - August 2012
* Provided aid to Staff Assistant and Office Coordinator, as well as occasional projects for legislative
assistants and staff
* Developed working knowledge of Capitol Hill practices and procedures; gained valuable communication skills in
dealing with constituent concerns
* Projects included US Farm Bill research, Medicare and Medicaid healthcare research
George Street Observer, College of Charleston, Charleston, SC
Staff Writer, August 2012 - May 2013
* Wrote several special interest and newspaper articles for College of Charleston weekly newspaper
ADDITIONAL EXPERIENCE
Starbucks Coffee Co., Barista, October 2010 - May 2012
College of Charleston New Student Programs, Orientation Intern, May - August 2008
SKILLS
* Computer proficiency: Word, Access, PowerPoint, Excel, Publisher and Adobe Acrobat
* Arabic: beginner proficiency; basic literacy
ACTIVITIES
Student Government Association, College of Charleston, September 2012 - May 2013
* Acted as liaison between the student body and the Faculty Senate
Note: Plain text resumes may be more than one page, as they are typically being scanned into a computer database
rather than read by a person. The words are in left justification with only bold face or all caps to set sections apart.
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SAMPLE COMBINATION RESUME

Jessica Krasny
311 Mimosa Lane, Charleston, SC 29401

(843) 577-0002  krasny@g.cofc.edu

Summary of Qualifications
 Experience in designing public relations materials: press releases, newsletters, surveys, and brochures
 Knowledge of cutting edge social media platforms including FaceBook, Twitter and YouTube
 Comfortable with public speaking; excellent oral and written communication skills
 Computer literate in Microsoft Office programs, InDesign, Photoshop and Illustrator
Education
College of Charleston, Charleston, SC
Bachelor of Science in Communication, May 2013
Minor: French
Paris University, Paris, France
Study Abroad, Summer 2012
 Video Production Course: Gained experience in camera usage, shot variety, and editing in the production of
video projects: A Traveler’s Excursion and Secrets of Henry the First
Relevant Knowledge
Public Relations Campaigns, College of Charleston, Spring 2013
 Organized a campaign for a local non-profit to increase visibility and donations
 Created different media to promote annual fundraising drive: brochures, press releases, and news articles
Experience
Anderson Communications, New York, New York
Public Relations Intern, Summer, 2013
 Categorized and chronicled media mentions of current clients in New York publications
 Posted public relations updates on social media sites including Facebook, Twitter and YouTube
 Researched new social media and mobile applications
 Created and maintained editorial calendars, events calendars, and client database
 Assembled and distributed press kits including press releases and pitch letters
Piccolo Spoleto Festival, Charleston, SC
Intern, May - June 2011
 Distributed ticket brochures, program guides and marketing materials for annual arts festival
 Managed the press room during the festival; scheduled interviews; packaged and distributed press kits
 Served as the house/event manager for over 28 theatrical, art, and dance productions
Work Abroad Experience
Collège François Premier, Villers-Cotterêts, France
Foreign Language Assistant, May - August 2012
 Organized, planned, and taught classes in a foreign language program
 Strengthened French communications skills by living with a native family
Activities
Zeta Tau Alpha Sorority, 2012 - Present
 Act as Alumni Relations chair, contacting past members and creating newsletters
 Volunteer at various philanthropic events for the Charleston Animal Society, Breast Cancer Awareness Week,
and the Ronald McDonald House
Note: Jessica chose to add a "Summary of Qualifications" section to point out several skills needed in
the Public Relations field; she also wanted to emphasize her international experience.
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SAMPLE FUNCTIONAL RESUME
555.555.1234
email@g.cofc.edu

AMBER ANISTON
1 Trolley Road Apt 4
Summerville, SC 29485
OBJECTIVE

To contribute relevant experience, educational background, and linguistic skills to a Teaching of English as a Second
Language position in Japan
SKILLS AND ACCOMPLISHMENTS
Teaching and Leadership:
■ Established advanced classroom management skills to ensure successful teaching of associates
■ Cross-trained, supervised, and evaluated activities of associates (20-25) of various ethnic backgrounds
■ Provided group/one-on-one intensive training to new associates, including classroom instruction/workshops,
mentoring and providing feedback to associates, and facilitating presentations
■ Oversaw and coordinated receiving supplies, proper storage/rotation, food and drink preparation, production, and
quality
■ Managed and coordinated daily shift operations for full service area restaurant, including training and supervising
employees (15-18)
Languages and Computer Skills:
■ Native fluent in English and extensive language training in Japanese including all hiragana, katakana, 300+ kanji,
and conversational skills in business and colloquial Japanese
■ Successfully tutored Japanese and English students in English and Japanese respectively
■ Translated entire literary works from Japanese to English including Kitchen by Yoshimoto Banana
■ Proficient/knowledgeable: Microsoft Windows XP, Office XP (Word, Excel, PowerPoint), and various in-house
center programs and databases in Japanese and English
Customer Service:
■ Provided excellent customer service support including professional handling of a call center’s customer
inquiries, credit authorizations, and resolving payment/billing and escalated account issues
■ Assisted in managing daily operations and customer service department, ensuring optimum service and
satisfaction of an upscale restaurant
■ Educated service staff to augment customer service by increasing profits through suggestive selling
■ Accountable for development of employees, sales and customer service at Starbucks establishments, with annual
sales revenue up to $1,500,000
EDUCATION
Bachelor of Science in International Business, Minor in Japanese ■ GPA: 3.6
College of Charleston, Charleston, SC – May 2013
Activities: College of Charleston Japanese Club and International Club
WORK EXPERIENCE
Starbucks Coffee Co., Summerville, SC
McAlister’s Deli, Summerville, SC
First Data, Summerville, SC

Certified Barista
Waiter
CSR/Associate Trainer

November 2012 - Present
June 2011– November 2012
June 2010– February 2011

Note: Amber's work experience is not relevant to what she is seeking; so she chose to
highlight her skills and accomplishments in order to better communicate her qualifications for a
teaching abroad position.
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SAMPLE RESUME FOR AN INTERNSHIP

JASON VARITEK
varitek@g.cofc.edu
(843) 789-3654
LOCAL
18 Central Avenue
Charleston, SC 29402

PERMANENT
1449 Jules Avenue
Ravenel, SC 29470

SUMMARY
Rising senior with interest and knowledge of supply chain management, procurement, and global commerce,
as well as strong leadership and teamwork skills seeking an internship in the transportation industry.
EDUCATION
Bachelor of Science in International Business, May 2014
Minor: Global Logistics and Transportation
College of Charleston, Charleston, SC
RELEVANT KNOWLEDGE
Global Commerce and Enterprise, College of Charleston, Spring 2013
 Designed a project to export a local tea product to the international market
 Analyzed industries and markets; facilitated the transportation of the product through the exportation
process
 Completed the necessary export documentation including the Bill of Lading and the Certificate of Origin
Designing and Managing the Supply Chain, College of Charleston, Fall 2012
 Analyzed different aspects of the supply chain including distribution strategies, risk pooling,
procurement strategies, and distributor integration
 Performed calculations using the centroid method to determine optimal warehouse
locations as well as resource applications
ACTIVITIES
Alpha Pi Omega
President/Vice President of Administration, 2012 - present
 Led the organization in coordination and participation of numerous service projects
throughout the Charleston area
 Organized and facilitated weekly meetings; delegated tasks and empowered fraternity
members
 Increased membership to nearly double its previous size
Student Port Club, 2012 - present
Finance Club, 2012 - present
WORK EXPERIENCE
Boulevard Diner, Charleston, SC
Server, August 2011 - present
 Worked effectively with restaurant team members to ensure customer satisfaction in a fast-paced
environment
 Managed and reconciled individual daily sales between cash and Point of Sale computer system
 Trained new employees on responsibilities and general safety procedures
REFERENCES
Available upon request
Note: Jason doesn’t have much work experience, so he is focusing on the knowledge he has gained from
classes in his major. The one job he has held is not related to his objective, but he has listed the job
responsibilities that most closely relate.
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SAMPLE RESUME FOR NON-RELATED MAJOR

Christine Edwards
edwardscb@g.cofc.edu ■ (803) 271-2712
School: 178 Green Street, Charleston, SC 29424
Permanent: 199 Pleasant Drive, Columbia, SC 29615

Objective

To obtain an internship in information technology utilizing programming and
communication skills

Computer
Skills

Programming Languages: Java, C++, PHP, HTML
Tools: Microsoft Office (Access, Excel, Word, PowerPoint), Adobe Creative
Suite, DreamWeaver; Cascade; MS Visual Studio
Operating Systems: Windows 7/XP, LINUX, UNIX

Work
Experience

Information Technology Assistant, September 2013 - present
APAC Manufacturing Company, Charleston, SC
Assist Computer Support team in writing a payroll program utilizing C++
language and programming codes
Set up database in Access in order to maintain employee information
including names, addresses, hire dates, and other necessary
information; ability to cross reference and search
Gain exposure to a variety of software applications, as well as
hardware requirements, in a business setting
Student Assistant Web Master, Summer 2013
Department of Student Life, Charleston, SC
Developed new web pages in Cascade Server web content management
system under direction of the Division Webmaster
Developed forms to collect data online using PHP and error checking with
JavaScript
Visitor Greeter, August 2011 - May 2013
Charleston Visitor Center, Charleston, SC
Provided information about the Charleston area to visitors, answered
questions, gave directions

Education

College of Charleston, Charleston, SC
Bachelor of Arts in Philosophy, Minor in German, May 2014
Elective coursework in computer science/computer information systems

Activities

Philosophy Club, Fall 2012 - Present
Habitat for Humanity, Spring 2013

Note: Christine’s major is not directly related to her job objective, so she put her related skills
and experience first in order to attract the reader's attention.
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E-mail Resume Tips
E-mail makes it possible for you to respond instantly to an opportunity, but if not
done correctly, your resume may be overlooked or deleted before it is read.
Whenever possible, copy a plain text resume into the body of your e-mail message,
rather than sending your resume as an attachment. Why?
 Attachments may contain viruses, particularly if they are in Microsoft Word.
 Firewalls may stop e-mail attachments from entering a company network.
 Recruiters may not take the time to open the attachment.
CREATE A PLAIN TEXT RESUME AND COVER LETTER
A text resume will be stripped of formatting features such as bold and italics, so it may not appear very attractive
to you. However, it will be universally compatible with all systems. To convert your resume from MS Word to
plain text:
 Open your resume document, go to Edit > Select All and change the font to Courier 12 point; go to File >
Page Setup and change the left and right margins to 1.5 inches.
 Go to File > Save As > under “Save as Type,” select “Plain Text.”
 Select “yes” at the prompt that warns about features being compatible.
 Name and save this file, then reopen the file, which should now have a text (.txt) extension.
 Review and clean up your document:
- Insert space where necessary
- Left-justify all text
- Change bullets to asterisks or dashes
- Take out tabs and centering
- Change or remove symbols that didn’t convert properly
 Save your work!
TEST THE FILE
Open your text resume, copy and paste it into your email message box and send it to yourself and a few friends
to ensure that the text transfers properly.
CREATE THE E-MAIL MESSAGE
Follow the employers’ directions for applying to each position! Requirements and instructions will differ, based
on the individual company’s needs. If no specific instructions are given:
 Open your email program and set the message format to plain text, not HTML.
 Make the message Subject memorable! ‘My resume” isn’t going to grab the attention of busy person. Make
the subject line relevant, and include your name, e.g. “Resume of Jane Smith – Copy Editor position.”
 Now create a “cover letter” message just as you would in print, except leave off your mailing address, the
date, and the recipient’s mailing address. The message will begin with the salutation, e.g.: “Dear Mr.
Jones:”
 Type your “signature” at the bottom of your “cover letter”. Avoid clever quotations/sayings in your email
signature.
 After your signature, add a couple of blank lines and the text notation.
====================Resume Text Below=======================

 Add a couple more blank lines, then paste the text from your ASCII resume into the body of the email
message.
- Unless the employer has requested no attachments, attach your resume (in Word or PDF
format). This will accommodate employers who prefer a traditional resume. It doesn’t hurt to
send your resume in both formats!
Tip: When posting a resume to an online resume builder,
use your plain text resume, and cut and paste it to fill the online form.
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Resume Planning Worksheet - Traditional Resume
Identifying information:
first name, middle initial, last name
current address, telephone number, e-mail address
permanent address, telephone number

OBJECTIVE
A (An) x position utilizing my x, y, and z skills OR A position in x that would benefit from my x and y experience

EDUCATION
college, city, state
degree, month, year to be received
major(s), minor(s), concentration(s)
grade point average (if above a 3.0)
related coursework (maximum of 6 classes; only if applicable to objective)

EXPERIENCE (volunteer or paid. List most recent experience first.)
title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty
describe another responsibility or duty
(over)
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title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty

title, name of organization, city, state, and dates of employment
leading with an action verb, describe what you did at the organization
describe another responsibility or duty
describe another responsibility or duty

SKILLS (specify computer languages or special skills, including working knowledge, proficiency, or fluency
in languages other than English)

ACTIVITIES (list leadership positions, memberships or affiliations)
name of organization, title or position (if applicable)
name of organization, title or position (if applicable)
name of organization, title or position (if applicable)

HONORS AND AWARDS (if listing awards, tell the employer what the award was for)
name of honor or award, date received
name of honor or award, date received
name of honor or award, date received

REFERENCES
26

Available upon request
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